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Overview

e XilinxVivadotoolis a software for simulation, synthesis, implementation and analysis of
HDL designs for Xilinx FPGAs.
* HW development

* Inthistutorial, you will only focus on HW development:
e XilinxVivadointerface
 How to create a project
* How to add/create design and simulation files
* How to run simulation/debug
* How to perform synthesis/implementation (with constraintfiles)
 How to add Xilinx IPs to your project

* Vivado Design Suite User Guide: https://docs.xilinx.com/r/2021.1-English/ug893-vivado-ide/Introduction



https://docs.xilinx.com/r/2021.1-English/ug893-vivado-ide/Introduction

Creating a New Project



Creating a New Project

* Launch Xilinx Vivado and click on Create Project in Quick Start tab (or click on File -> Project
-> New). Set your project name and location, then click on Next.
* You can also open an existing project by clicking on Open Project in Quick Start tab (or
click on File -> Project -> Open), then browsing and selecting project_name.xpr file.

New Project X

Project Name

_ Enter a name for your project and specify a directory whera the project data files will be stored, '

File Flow Tools Window Help Q- Quick Access Eroject name:  [project 1] ]
Project location: /homefamert/Documents [
' [ Create project subdirectory
v | VA D O Project will be created at: fhome/amert/Documents/project_1
HLx Editions

Quick Start

Create Project »

Open Project »

Open Example Project >




Creating a New Project

» Select project type as RTL Project and click on Next. In the next step, you can either add
design sources/constraint files by clicking on Create File button or you can skip this step by
clicking on Next (you can create files after you created the project).

New Project x New Project x

Project Type Add Sources

Specify the type of project to create, ‘ Specify HDL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create '
a new source file on disk and add it to your project. You can also add and create sources later,

(e) ETLProject
You will be able to add sources. create block designs in IP Integrator, generate IP. run RTL analysis. synthesis, +‘
implementation, design planning and analysis.

Do not specify sources at this time

Post-synthesis Project
You will be able to add sources, view device resources, run design analysis, planning and implementation.

1f0 Planning Project
Do not specify design sources. You will be able to view part/package resources, Use Add Files, Add Directories or Create File buttons below

Imported Project
Create a Vivado project from a Synplify, XST or ISE Project File.

Example Project
Create a new Vivado project from a predefined template.

Add Files ‘ | Add Directories | ‘ Create File

Target language: Simulator language: | Mixed ~
®




Creating a New Project

You should select an FPGA device or Board for your project. In order to select PYNQ-Z2
board, switch to Boards tab and select pyng-z2. Then click on Next and Finish.

New Project x

Default Part
Choose a default Xilinx part or board for your project. '

Parts | Boards

Reset All Filters

Category: | All v | Package: | All w | Temperature: | All v

Family: All ~ | Speed: Al ~ | Static power: | All -
Search: | Q- v

Part /0 Pin Count  Available IOBs  LUT Elements  FlipFlops  Block RAMs  Ultra RAMs DS
XC/VK4LDTMVLLDE-3  Llog Sau £a/0UU BT PV VE-T-1T] u FIRN
HeTwwd15tffvl158-2 1158 350 257600 515200 ea0 0 21
xc7wwd15tfivl1582L 1158 350 257600 515200 220 0 21
XcTwrd15tfful158-1 1158 350 257600 515200 880 0 21
HeTwrd15tffv1927-3 1927 500 257600 515200 880 0 21
XcTwed15tffv1927-2 1927 500 257600 515200 a0 0 21
XeTwrdl5tffvl927-2L 1927 500 257600 515200 880 0 21
HCTwrd15tff1927-1 1927 500 257600 515200 880 0 21
HeTwrd85tffgl157-3 1157 500 303600 607200 1020 0 28
XcTwrd85tffgl157-2 1157 500 303600 607200 1030 0 238
®c7wwd85tffglls7-2L 1157 500 303600 607200 1030 0 28
®eTwrd85tffgl157-1 1157 600 303600 607200 1030 0 28
xc7wrd85tffgl158-3 1158 350 303600 607200 1030 0 28 .,
< >

New Project x

Default Part
Choose a default Xilinx part or board for your project.

Parts | Boards
Reset All Filters

vendar: | All v | Mame: | All

Search: Q- w

Preview

Display Name
Alpha-Data ADM-PCIE-7V3

Kintex-Ultrascale Alphadata board

ZedBoard Zynq Evaluation and Development kit
add Daughter Card Connections

pyng-z2

Artix-7 AC701 Evaluation Platform
Daugt rd Connections

Update Board Repositories

~ | Board Rew:

Vendor

alpha-data.com

alpha-data.com

em.avnet.com

tul.com.tw

xilirpe com

Latest A4

File Version

11

1.0

1.4

~




Vivado Interface



Vivado Interface

project_1 - [fhome/amert/Documents/project_1/p
File Edit Flow Tools Reports Windew layout View Help Ready
=, - b B & X Default Layout ~
Flow Navigator PROJECT MANAGER - project_1 2
~ PROJECT MANAGER N
Sources ? 00X Project Summary 200 X
£ settings
Q' T & + -3 Overview | Dashboard
Add Sources
Design Sources Wy
Language Templates s~ constraints Settings  Edit
I P Catalog ~ = Simulation Sources Project name: project_1
sim_1 Project location: /home/amert/Documeants/project 1
v IP INTEGRATOR » [= Utility Sources Product family: Zynq-7000
Create Block Design Project part: pyng-z2 (xc7z020clg400-1)
Top module name: Mot defined
Target language: Werilog
. Simulator language: Mixed
Hierarchy = Libraries
v SIMULATION
- Board Part
Run Simulation Properties 2 _0C X
o Display name: pyng-z2
v RTL ANALYSIS Board part name:  tul.com.tw:pynqz2:part0:1.0
5 Open Elaborated Design Erariehs o L0
Connectars: No connections -
Repository path: rfopt/Xilinxvivade/2019.1/data/boards/board files
v SYNTHESIS
URL: http:/fwww.tul. com.tw
¥ Fun Synthesis Board overview: pyngz2
> Open Synthe Design
v
v IMPLEMENTATION < 2
¥ Run implementation Tcl Console x Messages  Log |Reports | Design Runs 2 _00
> en Imple ted Design > A =
‘ ’ Q¥ ¢ Il B B @
) close_sin ~
v PROGRAM AND DEBUG - INFD: [Simtcl 6-16] Simulation closed
m . close_project
¥4 Generate Bitstraam create_project project_1 /home/amert/Documents/project_1 -part xc7z020clg400-1
. INFO: [IP_Flow 19-234] Refreshing IP repositories
> Open Hardware Manager | INFO: [IP_Flow 19-1704] Mo user IP repositories specified
! INFO: [IP_Flow 18-2313] Loaded Vivado IP repository '/opt/Xilink/Vivado/2019. 1/data/ip’.
“) create_project: Time (s): cpu = 00:00:67 ; elapsed = 00:00:05 . Memory (MB): peak = 6781.410 : gain = 0.800 : free physical = 1576 ; free virtual = 13510
. set_property board_part tul.com.tw:pynq-z2:part:1.0 [current_project]
: v
< 3




Vivado Interface

Project Settings

Runs Behavioral
Simulation

Compiles RTL code
and loads RTL netlist

Implementation
run and settings

File  Edit

Flow Tools

Reports
.A

<

<

<

<

<

<

£ settings
Add Sources
Language Templates

I P Catalog

IP INTEGRATOR.

Create Block Design

SIMULATION

Run Simulation

RTL ANALYSIS
5 Open Elaborated Design

SYNTHESIS
P Run Synthesis

en Synthe:

IMPLEMENTATION

P Run Implementation

en Implemented

PROGRAM AND DEBUG
¥ Generate Bitstream

> Open Hardware Manager

Window Layout View Help Ready
T Default Layout -
PROJECT MANAGER - project_1 2?2 X%

Prr ect Summary

sources ?2 00 X ?Dﬁ»l
Q = £ + &* Overview | pashboard
Design Sources ~11
> Constraints Settings  Edit
~ = Simulation Sources Froject name: project 1
sim_1 Project location: /home/amert/Documeants/project 1
» [= Utility Sources Product family: Zynq-7000
Project part: pyng-z2 (xc7z020clg400-1)
Top module name: Mot defined
Target language: Werilog
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, Simulator language: Mixed
Hierarchy = Libraries Compile Order
> \ery Board Part
Propeities ? 00X
o Display name: pyng-z2
Board part name: tul.com.tw:pyng-22:part0:1.0
) . i Board revision: 1.0
Shows dES|gn andsimulation Connectors: No connections J
ﬁles Wlth pl'oject hieral’chy Repository path: loptXilimevivado/2019.1/data/boards/board_files
— — URL: http:/fwww.tul. com.tw
Board overview: pynqz2
~
- _— 2
Tcl Console x Messages | Log |Reports | Design Runs ?-00
Q x £ Il B B @ : .
o Messages tab shows useful information
close_sin N . ™
- ITFU‘ [Sintcl 6-16] Sinulation closed (wa rn|ng5'error5) about your design.
. close_project
create_project project_1 /home/amert/Documents/project_1 -part xc7z0 Oclg400-1
. INFO: [IP_Flow 19-234] Refreshing IP repositories
| INFO: [IP_Flow 19-1704] Mo user IP repositories specified
! INFO: [IP_Flow 18-2313] Loaded Vivado IP repository '/opt/Xilink/Viv do/2019. 1/data/ip’.
“ create_project: Time (s): cpu = 00:00:67 ; elapsed = 00:00:05 . Memo y (MB): peak = 6781.410 : gain = 0.800 : free physical = 1576 ; free virtual = 13510
. set_property board_part tul.com.tw:pyng-z2:part:1.0 [current_projec ]
: v

o

Summary of project
and results




Vivado Interface

* From Settings under PROJECT MANAGER tab, you can change the settings of your
project (e.g., Board or FPGA).

Project Settings g;enclef;ila\ues for uanious settings Used throughout the design flow. These g
General settings apply to the current project.
Simulation
Elaboration Name: nroiect 1
oon synthesis ) ; 5
Flow Navigato = 8 pemencation Preject device B pyng-22 (xc72020clg400-1) E
Bitstream Target language: |1 Choose & device for your project -
v PROJECT MANAGER >R Default library wil_defauttiip
£ settings Tool Settings Top module name: | designl [
Project
Add Sources IP Defaults Language Options
Board Repositary
Language Templates sourcs File Verilog options: verilog_version=Verilog 2001 E‘
Display Generics/Parameters: ]
IF P Catalog WebTalk Loop court: 1,000 =
Help
» Text Editor

3rd Party Simulators
> Colors
Selection Rules
Shartcuts
> Strategies
> Remote Hosts
> Window Behavior

estore,



Vivado Interface

* From Settings under PROJECT MANAGER tab, you can change the settings of
your project (e.g., Board or FPGA).
* For example, you can change the font type and size of the text editor.
T )

Text Editor = Fonts and Colors
Project Settings Speciy fonts for Vivado text editor and colors for languages that are not g
syntax colored.

General
Simulation
Elaboration Themes: | Vivado Default Theme ~ ~
Synthesis R
Implementation Name: | Monospaced v | sSize 13 T
Bitstream
- Background: [ 238, 255, 255 v
Tool Settings Foreground: . o.00 >
Project current Line Background: [ ] 255, 255. 215 ~
1P Defaults Find Highlight Background: B 0. 255, 0 o
Soare remoston Selection Background I 160,175, 240 .
Display Matching Words Background: [ ] 200, 255, 200 -
r‘/e‘ma‘k Current Breakpoint Background: | [_| 240, 249, 156 v
~ Text Editor Cursor Color; oo ~
Code Completion
Syntax Checking
Tabs
Fonts and Colors
verilog
WHDL
el Preview
xde 1 <
Trigger State Machine Hello, World,
3rd Party Simulators vorld,
> Colors 4 vorld:
Selection Rules
shortcuts
> strategies
> Remote Hosts N

> Window Behavior < >




Vivado Interface

Language Templates under PROJECT MANAGER tab shows useful

Xilinx IP constructions.

Flow Navigator
~ PROJECT MANAGER
£ Settings
Add Sources
Language Templates

¥ P Catalog

nguage Templates x

Select a language template

Templates

]
A
~

- Q

o)

T B

~ [ Operators
Bitwise
Logical
Replicate/Concatenate
Shift
Unary Reduction
» [ User Defined Functions & Tasks
Device Macro Instantiation
Device Primitive Instantiation
IP Integrator HODL
Simulation Constructs
Synthesis Constructs
Xilinx Parameterized Macros (XPM)
WHDL
SystemVerilog
XDC
Debug

Preview
1.

Verilog and



Vivado Interface

» See Vivado IDE Viewing Enviroment chapter of Vivado Design Suite User Guide!l.

Search in document

Keywaords Q

Revision History
Introduction
Using the Viewing Environment

— Vivado IDE Viewing
Environment

Menu Bar

Menu Command Quick
Access Search Field

Main Toolbar

Flow Navigator
Layout Selector
Project Status Bar
Data Windows Area

Workspace

Vivado Design Suite User Guide: Using the Vivado IDE (UG893)  UG893  2021-07-14 ¥7

B
0

Vivado IDE Viewing Environment + e @

The following figure shows the Vivado IDE viewing environment. You can interact with the Vivado IDE through mouse, keyboard, or Tcl input.

* ?
Tip: For quick access to information on different parts of the Vivado IDE, click the Quick Help button in the window or dialog box, or
press the F1 key.

The main components of the viewing environment are:

Menu Bar

Main Toolbar

Flow Navigator

Data Windows Area

Menu Command Quick Access Search Field
Workspace

Project Status Bar

Layout Selector

Status Bar

. Results Windows Area

©ONO O~ ONE

[
o

[1] https://docs xilinx.com/r/2021.1-English/ug893-vivado-ide/Vivado-IDE-Viewing-Environment




Adding/Creating Design and Simulation Files



Create a Design Source
* Foryour design, you should add a design source (*.v file). Click on Add Sources in Flow

Navigator Window or "+" button on Sources window or File -> Add Sources on menu bar,
select Add or create design resources and then click on Next.

FEile  Edit Flow Tools Reports
!
= « >, ¥

Flow Navigator = 8 ?

Add Sources
~ PROJECT MANAGER

£ settings V‘VﬁDaO’

Add Sources

Add Sources
This guides you through the process of adding and creating sources for your project

Add or create constraints
Language Templates

®) Add or create design sources

i} IP Catalog Add or create simulation sources
Sources ? 00 X
a 'z & + o

Design Sources
b Constraints
~ = Simulation Sources
sim_1
» = Utility Sources

& XILINX

A )
Hierarchy  Libraries Compile Order A




Create a Design Source

* Clickon Create File button, name your source file (e.g., designl.v) and click on Next.
e If youwant toadd an existing file to your project, click on Add Files and select the files
that you want to add to the project.

Add Sources X

Add or Create Design Sources

Specify HDL, netlist, Block Design, and IP files, or directories containing those file types to add to your project. '
Create g new source file on disk and add it to your project.

+ Create Source File X

Create a new source file and add it to your project.

Use Add Files, Add Directories or Create File buttons below Eile type: ® erilog M
File name: |designl.v |
File location: | = =<Local to Project= w
Add Files | | Add Directories ‘ ‘ Create File

2) < Back Cancel




Create a Design Source

Set your module name (it is set as source file name per default) and click on OK. Then, you
will see your source file under Design Sources tab on Sources window.

Define Module X

Define a module and specify /0 Ports to add to your source file,
For each port specified:

MSE and LSB values will be ignored unless its Bus column is checked. ' Sources 2 _ 0O X
Ports with blank names will not be written. :
a T & + #
Module Definition

~ [ Design Sources (1)
® = designl (designl.v)
¥ Constraints

Module name: designl

1/O Port Definitions ~ = Simulation Sources (1)

> sim_L (1)
+ b Utility Sources
Port Name Direction Bus MSE LSBE
input  ~ )
Hierarchy Libraries Compile Order




Create a Design Source

* Open designl.vand write the following (or any other) Verilog code as an example and save
it.

designl.v ? —0aX
timescale 1ns / 1ps
fhomefamert/Documents/project_1/project_l.srcsfsources 1 X

module designl ( Q - $ B B X N B QO 7
input clk, 1 “timescale 1ns / lps ~
input [7:0] a,b 24
) P [ ] e 26 module designl(
input [15:0] c, 4 input clk,

output[l6:0] d input [7:0] a,b,
) ; 6 input [15:0] ¢,
! 7. output[15:0] d

' );

O o

reg [15:0] m; 15 reg [15:0] m;

reg [16:0] d; 11 reg [15:0] d;
12
always @ (posedge clk) begin ; 5 al’“"afﬁ(giﬁ?dge ctk) begin
m <= a*b; 150 end
16 !
end 17 always @(posedge clk) begin
18 d==m+ c;
always @ (posedge clk) begin }5 end
2
d <=m+ ¢c; 21 endmodule
end 22
endmodule : ~




Create a Simulation Source

* |Inorder to test yourdesign, you should add a simulation source. Click on Add Sources in
Flow Navigator Window, select Add or create simulation resources and then click on Next.

* Click on Create File button, name your simulationfile (e.g., design1_tb.v) and click on
Next.

* Set your module name (it is set as simulation file name per default) and click on OK. Then,
you will see your simulation file under Simulation Sourcestab on Sources window.

Sources x Netlist ? 00

a T (2 + o
~ = Design S Expand All (Ctrl+Equals)
® .. designl (designl
> Constraints
w [ Simulation Sources (1
v sim_1 (1
~ @ . designl_tb (designl _tb
® dut : designl (designl
» [ Utility Sources

Hierarchy Libraries Compile Order




Create a Simulation Source

* Opendesignl_tb.vand write the following example Verilog testbench code and save it.

‘ timescale 1ns / 1lps
module designl tb();

reg [7:0] a,b;
reg [15:0] c;
wire [16:0] d;

designl dut (a,b,c,d);

initial begin
a=0; b=0; c=0;
#10;
a=10; b=40; c=25;
#10;
a=53; b=19; c=100;
end

endmodule




Design Elaboration

e Design Elaborationand RTL Analysis
* |tcompiles RTL code and loads RTL netlist
* You cancheck RTL structure, syntax, and logic definitions
* You canview the schematic of your design

Project Summary x| designl.v x| designl_tb.v x| Schematic x 200
- Q M O C  3scells SONOPorts 99 Nets o
~ SIMULATION
Run Simulation
~ RTI ANAIYSIS K O q [16:0]
c _reg[16:
> Open Elaborated Design m_reg[15:0]
mi_i - C
: - C d[16:0
a[7:0] W70) 0[15:0) Q b @ [ !
v SYNTHESIS b[7:0] 11[7:0) D
) do_i
P Run Synthesis RTL_MULT : -
ol | RTL REG 10(15:0] ~\onsol RTL_REG
> Open Synthesized Design c[15:0] D J1[15:0]
RTL_ADD




Running Behavioral Simulation



Behavioral Simulation

* Before running simulation, first make sure that your simulation source (testbench) is
selected as top simulation module (its module name should be in boldcase letters) under
Simulation Sources tab on Sources window.

* Ifitisnot, right click onits name and click on Set as Top.
* Then, click on Run Simulation in Flow Navigator Window and click Run Behavioral

Simulation.

ace File v SIMULATION . .
Source File Properties

Run Simulation

move File from Project... Run Behavioral Simulation
~ RTL ANALYSIS

» 0Open Elaboratec i

v SYNTHESIS

P BEun Svnthesi




Behavio

ral Simulation

* If thereisno errorin yourdesign and testbench files, you will see the following simulation

screen.

project_1 - [/home/amert/Documents/project_1/project, - o =

File Edit Flow Tools Reports Window Layout Vew Run Help Ready
=, p,E B T <« » 200 ns v x (! Default Layout v
T F T I  51MULATION - Behavioral Simulation - Functional - sim_1 - designl_tb
+ PROJECT MANAGER M . -
Scop objec Untitled 2
£ settings
Q = 2 &« Q # |Q W e e H o« KM + -
Add Sources
. T at Name [+ Name
|nguage Templares ~ @ designl_tb U ck
T 1P catalog @ dut > ® a[7:0]
= glbl > ® b[7:0] 4 clic
v IP INTEGRATOR > W clLs:0] walz:0l
» WB[7:0
Create Block Design > W d[16:0] 17:0l
W c[15:0]
> W d[16:0]
v SIMULATION
Run Simulation
v RTL ANALYSIS
> Open Elaborated Design
< >V
v SYNTHESIS
P Run Synthesis Tel Console
> Open Synthesiz o T 21 B E @
launch_sinulation: Time (s): cpu = 00:00:02 ; elapsed = 00:00:22 . Memory (MB): peak = 6831.316 ; gain = 0.080 ; free physical = 349 ; free virtual
© IMPLEMENTATION Vivade Sinulator 2019.1
Tine resolution is 1 ps
» Run Implementation relaunch_sin: Time (s): cpu = 00:00:09 ; elapsed = 00:00:47 . Memory (MB): peak = 6839.320 ; gain = 8.004 ; free physical = 347 ; free wirtual = 13
> Open implemented Design ~
< >
~ PROGRAM AND DEBUG ]

Sim Time: 1 us

LY ]
L |

4

|

Save waveform configuration
Zoom in to area where cursor is
Zoom out from area where cursoris

Fit whole run into waveform

Go totime=0

Go tothe lasttime



Behavioral Simulation

Untitled 2

* You canchange radix of the signals in the QM@ alx dH #
waveform window. For example, right click on
signal name and then select Radix -> Unsigned

Go To Source Code

decimal to change representation of this signal -
from hexadecimal to unsigned decimal.

e Similarly, you can change the color of the signal. .
For example, right click on signal name and then S ’
select Signal Color -> Yellow to change the color e
of this signal from lime to yellow. E?J s

Reverse Bit Order
B New Group
New Divider

# New virtual Bus




Behavioral Simulation

* Changeradix of the signals to the unsigned decimal. Then, zoom in to the beginningof the
simulation. Now you can observe outputd.

Untitled 3*

Q W @ g I « I« r o

42,700 ns |~

4 clk
> W aly.0]

> W B[7:0]

> W c[15:0]




Behavioral Simulation

* Inthe toolbaron the top, you will see some shortcut buttons for simulation.
File  Edit Flow Tools Reports Window Layout View Run  Help

= > B & T “ » » 1[us v|= c

|4 Restart the simulation. Use this to restart the simulation with current state of the design.

» Run All. Use this to run simulation until it reaches a stop/finish command in testbench..

». Run for specified time. Use this to run simulation for specified time.

1| us ~  Time and unit. Use this to specify run time and unit for the command above.

C Relaunchthe simulation. Use this to relaunch the simulation for elaboratingthe
changes you made in your design.



Behavioral Simulation

* |Inthe Scope window, you can see the design hierarchy. When you select a scope in
the Scope window, all HDL objects visible from that scope appearin the Objects window.

SIMULATION - Behavioral Simulation - Functional - sim_1 - designl_tb

Scop Object Untitled 4
Q = = # Q g4 | H @ © 1 =+ 4 T &
Name ~ Name Value n
~ {II designl_tb 14 clk 0
1 dut > B al[7:0] 35
& glbl > B b[7:0] 13
> W c[15:0 0084 » Walnol
> & d[16:0] 00453 > W b[7:0]

> W c[15:0]
> W d[16:0]




Behavioral Simulation

 When you start simulation, you will see signals defined in testbench on the waveform. In
order to observe internal signals (for debugging), click on the module you want to
investigate on Scope window. Then right click on the signal you want to observe in the
Objects window and click on Add to wave window.

Scop Object Object
a * & | a o a ™
Name Value s
~ -~
Neme ] Name Value M oclk 0
- ﬂ—d"c"{""‘.' -7tb M cl 0 > W al7:0] 35
I: Sdut|] = > W a[7:0] 35 s B b[7:0] 13
0 giol > B b[7:0] 13 > W c[15:0] 0064
» B c[15:0] 00564 S ) S I
w > B mlg - -
» W d[16:0] 00453 ‘l Add to Wave Window
> B m[15:0] 03ef 1 Log to Wave Darapase
Go to Source Code
Radix 3
< Eorce Constant...
Force Clock...
Eemove Force
L4 > v < v [} Default Radix 3




Synthesis/Implementation



Constraint File

* Constraintfile
* Timing: For setting clock frequency of your design
* Placement: For floorplanning
* |/O: Assigning your design inputs/outputs to FPGA pins
e Other user-defined constraints (i.e., false paths)

* Foraddingthe constraintfile, click on Add Sources in Flow Navigator Window, select Add or
create constraints and then click on Next.

* Click on Create File button, name your simulationfile (e.g., const.xdc) and click on Next.

* Then, you will see your source file under Design Sources tab on Sources window.



Constraint File

We will only use timing constraint for clock frequency/period [

create clock -name clk -period PERIOD [get ports PORT NAME]

Sources
Q T & +
~ [ Design Sources (1)
® = designl (designl.v)

v Constraints (1)

w [ constrs_1 (1)

" const.xdc

~ = Simulation Sources (1)

woosim_1 (1)

~ @ 5 designl_tb (designl_thw) (1)

@ dut: designl (designl.v)
> Utility Sources

Hierarchy = Libraries Compile Order

?

—0OoX

Project Summary x| const.xdc#* x

Jhomefamert/Documents/project_1/project_1.srcs/constrs_l/new/const.xdc

Q W «

‘ create_clock -name clk -period 10.000 [get_ports clk]

x B B X N/ @ Q

ing 3 2 ke

[1] https://docs xilinx.com/r/2021.2-English/ug835-vivado-tcl-commands/create_clock



Synthesis

» Synthesistranslates RTL code to a netlist which defines the circuit
* You can change synthesis strategy (i.e., area optimized or performance optimized)
from synthesis settings (right click on SYNTHESIS -> Synthesis Settings)
* For starting synthesis, click on Run Synthesis.

v RTL ANALYSIS

~ RTL ANALYSIS ® de
> Open Elaborated Design » Open Elaborated Design

v E

v SYNTHESIS Local

» Rul Synthesis Settings... v SYMNTHESIS

>

> o P Run Synthesis

ndq

~ IMPLEI »» Lsunch Next Step: synth_design » Open Synthesized Design
> Rui
s Op Create Synthesis Runs...
P ~ IMPLEMEMNTATION
v PROGH P Run Implementation
¥ Ge

> Open Implemented Design

Op!

[1] https://docs xilinx.com/v/u/2021.1-English/ug901-vivado-synthesis



Synthesis

» After synthesisis finished, you can directly start implementation, open the synthesized

design or view synthesis reports.
* You can see synthesis report summary in Project Summary.

utilization Post-Synthesis | Post-implementation

o Synthesis successfully completed. Graph | Table
Next

Resource Estimation Available Utilization %

@® Run Implementsation LUT a7 53200 0.16

Open Synthesized Design FF 23 106400 0.03

Wiew Reports 10 50 125 40,00

Don't show this dialog again BUFG 1 2z 3,13




Synthesis

» After synthesisis finished, you can directly start implementation, open the synthesized

design or view synthesis reports.
* You can see synthesis report summary in Project Summary.

* Fordetailed report/results, open the synthesized design.

w Navigat

+ PROJECT MANAGER
& settings
Add Sources
Language Templates

¥ P Catalog

v IP INTEGRATOR

Create Block Design

~ SIMULATION

Run Simulation

v RTL ANALYSIS
> Open Elaborated Design

v SYNTHESIS
Run Synthesis
~ Open synthesized Design
Constraints Wizard
Edit Timing Constraints

Set Up Debug

e}

Report Timing Summary
Report Clock Networks

Report Clock Interaction

Report Methodology
Report DRC

Report Noise
Report Utiization

% Report Power

¥ schematic

SYNTHESIZED DESIGN - xc72020¢I3400-1

Netlist

E | L]
designl
> Nets

> LeafCells (2

Source File Prop

I const.xdc o
~
@ Enabled
Location: Ihome/amert/Docun
Type: XDC [+
Size: olke
Modied: Today at 01:08103 £

General | Pro

Device

Reports

Report
v Synthesis

v Synth Design (synth_

synth_1_synth_report_utilization_0

synth_L_synth_synthesis_report_0

v Implementation

Type

report_utilization

Options

Modified

10/4/22, 5:13 PM
10/4/22, 5:13 PM

Size

6.7 kB
1818




Implementation

* Implementation takesthe netlist with user constraintand maps it to actual FPGA

components!il,

e Similarto Synthesis, you can change implementation strategy
* For starting implementation, click on Run Implementation.

* After implementationis finished, you can start bitstream generation, open the
implemented design or view implementation report.
* You can see implementation report (area and timing) in Project Summary.

Implementation Completed X

Timing

‘Worst Negative Slack (WNS):

Total Megative Slack (TNS):

Number of Failing Endpaints:

Total Mumber of Endpoints:

Implemented Timing Report

Setup | Hold | Pulse Width

7.509 ns
0ns

0

17

[1] https://docs xilinx.com/r/2021.1-English/ug904-vivado-implementation/Revision-History

utilization Post-Synthesis | Post-Implementation

o Implementation successfully completed.

Next Graph | Table
Geepllnplaniantedibe=gn Resource Utilization Available Utilization %
Generate Bitstream LUT a7 53200 0.16

(® view Reports FF 33 106400 0.02
Don't show this dialog again 10 50 125 40.00
BUFG 1 32 313




Implementation

* Fordetailed report/results and the placed & routed design, open the implemented design.

Placed design

Flow Navigator L] IMPLEMENTED DESIGN - xc7z020cIg400-1

Netlist Device

5
=
-3

designl
v SIMULATION > Nets
Run Simulation > & Leaf Cells (20

~ RTL ANALYSIS

> Open Elaborated Design

UPETT Sy SEs T UEsTgn
v SYNTHESIS

» Run Synthesis

v IMPLEMENTATION > Open Synthesized Design

P Run Implementation

v IMPLEMENTATION Source File Properties
» Openimplemented Design » Run Implementation

1 const.xde o
~ Open Implemented Design =
Constraints Wizard ) Enabled
At Timinn Canctrainte Location: Ihome/amert/Documentsfproject 1
@ Report Timing Summary Type: XD E‘
REpOIL LIoeK NELROT S ¢ SHl

General | Prop

Report Clock Interaction

For detailed

Report Methodology

Lo Timina
timingreport Report DRC . —
Q =] Design Timing Summary
Rannrt Maica i
General Information 4
Report Utilization Timer Settings Setup Hold Pulse Width
W Keport Power Design Timing Summary Worst Negative Slack (WNS):  7.509 ns Worst Hold Slack (WHS): 023z ns Worst Pulse Width Slack (WPWS): 4,500 ns
For detailed M Schematic Clock Summary (1 Total Negative Slack (TNS): 0,000 ns Total Hold Slack (THS): 0.000 ns Total Pulse Width Negative Slack (TPWS): 0,000 ns
> lia Check Timing (49 Number of Failing Endpoints: 0 Number of Failing Endpairts: 0 Number of Faiing Endpoints: 0
ilizati Intra-Clock Path
utilizationreport © PROGRAM AND DEBUS ’ I”tra U"‘k Paths Total Number of Endpoints: 17 Total Number of Endpoints: 17 Total Number of Endpoints: 34
nter-Clock Paths
i Generate Bitstream Other Path Groups J All user specified timing constraints are met.
> Open Hardware Manager Timing Summary -impl_1 (saved)
vl

Timing summary




Implementation

* Fordetailed report/results and the placed & routed design, open the implemented design.
* Placed design

IMPLEMENTED DESIGN - xc7z020clg400-1

Netlist Device

M4
al
-3

m_req[2]_i_2 (CARRY4 o
m_reg[4] (FDRE)
m_reg[5] (FDRE)
m_reg[s] (FDRE)
m_reg[6]_i_1 (CARRY4)
m_reg[6]_i_3 (CARRY4
m_reg[7] (FDRE)
m_reg[B] (FDRE)
m_reg[9] (FDRE)
m_reg[10] (FDRE)
m_rag[10]_i_1 (CARRV4)

P . II
mjeq[lu]i(lila ;-—' - E g E
11] (FDRE
m_reg[11] . ]
m_reg[12] (FDRE) N 113 B n a
— 1 g
| i H
Cell Properties : E ] B
m_reg[14] i1 & [ ] [ [
@ 1] 1}
~ a a
Name: m_reg[14]_i_1 g g n
8 8 1]
Reference name: CARRY4 @ @ 1] i
g g ] 1]
Type: CarrylLogic . . " L
BEL: Fixed
= | ————— | hd

General FProperties Mets  Cell Pins




Implementation

* Fordetailed report/results and the placed & routed design, open the implemented design.
e Detailedtiming result (showing critical pathsin your design).
* Worst Negative Slack (WNS): If it is negative, then it means your design could not meet
the timing requirement (given in your constraint file) and your design has failing paths.
e Clickon WNS value to see critical paths.

Design Timing Summary

Setup Hold Pulse Width
Worst Megative Slack (WNS):  7.509 ns Worst Hold Slack (WHS): 0.232 ns Worst Pulse Width Slack (WPWS): 4,500 ns
Total Negative Slack (TNS):  0.000 ns Total Hold Slack (THS): 0.000 ns Total Pulse Width Negative Slack (TPWS): 0.000 ns
Number of Failing Endpoints: 0 Number of Failing Endpoints: 0 Number of Failing Endpoints: 0
Total Number of Endpoints: 17 Total Number of Endpoints: 17 Total Number of Endpoints: 34

All user specified timing constraints are met.




Implementation

* Fordetailed report/results and the placed & routed design, open the implemented design.
e Detailedtiming result (showing critical pathsin your design).

IMPLEMENTED DESIGN - xc72020¢lg400-1 2 X
Sources  Netlist 2 _ 00 |Device x designlv x designl_tbw x const.xdc x| Path 1-designl_timing_summary_routed =200
B o net (fo=33, routed 1667  5.048 ' clk_JBUF_BUFG ~

R FDRF Cirn CHE VAR AD | P mmrEi
m[15]__7 | © uatapath R
m_regl0] [ Delay Type Incr (ns) Path... Location Netlist Resource(s)
m_reg(1]  fdre € (1) 0.456 5504 Site: SLICE X44v42 4] m_reg[51/Q
m_reg(2] 0816 6319 ' m[s]
m_reg[2] i1 (CARRV# (00124 6443 Site: SLUCEX43v42 1 dI71_i4/0
m_reg(3] 0000 6443 J dI71i4.n_0
m_reg[3] CARR) _c.4 S[]_CC (r) 0.550 6.993 Site: SLICE_X43v42  {J d_req[7]_i_1/CO[3]
m_reg[4] (F 0.000 6993 /' d_req[7] 0
TLrEE] (FRE) ~ A ¥ _CLcc (00114 7107 Site: SLUCE_X43v43 @ d_reg[11] J_1/CO[3]
0 0000  7.107 /' d_regll1]i1n_0
path Properties o= [E B CARR) _carmya_Cl_CG (M0114  7.221 Site; SUCEX43v44 4 d_regll6]_i_1/CO[3]
Path 1 - -] 0.000 7.221 A xinx_opt_
B Summary = CARR) _carryd_Cl_ (N0.271  7.492 Site: SLICEX43V45 ] CARRY4/CO[0]
Name Path 1 0.000  7.492  doj16]
slack Zsoens FDRE Siter SLICE_X43v45 [ d_reg(161/D
Source B m realS1iC sin > v urn'va.r Time 7.492 y
o ————————— -
General  FProperties | Report | Cells = |« . >
Tl Console | Messages |Log |Reports |DesignRuns |Power |DRC | Methodciogy | Timing x ?2 00
RERE QO = H @ m Intra-Clock Paths - dk - Setup
T T - T A’ - _~ NEY . .- r - - PR - . - - — ~ -
Timer Settings e e R - T
Design Trming summary Path 1 7.509 5 2 m_reglSI/C  d_regl[l6I/D 100 ck dlic -
Clock Summary (1 L orEn 2 1900 a £ m_reglapL  a_regiLalu 2394 Lors uBLo WU ck K 7
» % Check Timing (49 Path 3 7.597 a4 2 m_reg[5]/C d_reg[15]/D 2.373 1.557 0.816 100 clk clk
& Intra-Clock Paths Path 4 7.671 4 2 moreg[S|/C  d_reg[L4]D 2.208 1.483 0816 100 ck clkc
ek Path 5 7.687 4 2 mreg(sl/C  d_reg[l2]/D 2.283 1.467 016 100 ck clk
Setup 7,509 ns (10} Path 6 7.690 3 2 m_reglSI/C  d_regl9liD 2.280 1.464 0816 100 ck clic
Hold 0.232 ns (10 Path 7 7.711 3 2 m_regsliC  d_regllllm 2.259 1.443 0816 100 ck el
Pulse Width 4,500 ns (20 Path g 7.785 3 2 m_reg[5]/C d_reg[10]/D 2.185 1.369 0.816 100 clk clk
Inter-Clock Paths Path 9 7.801 3 2 mreg[Sl/C  d_reg[8]/D 2168 1353 0816 100 ck clkc
Nthar Rath Granne 3 v ¢ Btk 104 RE-FT,) 3 R Wl A rants1in LRk 1 nolT 1An sl elle W
Timing Summary - impl_L (saved)




Implementation
For detailed report/results and the placed & routed design, open the implemented design.

[ ]
* Detailed tilizati It
etalled area (utilization) resuit.
Tcl Console | Messages |Log |Reports | Design Runs | Power |DRC | Methodology | Timing | Utilization x ? 00
a = £ «Q = % % Hierarchy &
»
Hierarchy ~ Name ©, sSliceluTs  Slice Registers slice LUT as Logic ~ Block RAaM  Bonded IPADs ~ BUFIO
summary {53200) (106400) (13300} (53200) Tile (140) (2 (16)
v Slice Logic designl a7 33 27 87 33 50 1
w Slice LUTs (=1%)
LUT as Logi
~ Slice Registers
Register as Flip Flo|
~ Slice Logic Distribution
~ Slice (=1%)
SLICEM
SLICEL ~
Y E ]
utilization_1




Synthesis & Implementation Messages

 Messages window displaysa filtered list of the Vivado log. Thislist includes useful
information such as the main messages, warnings, errors.

Tcl Console | Messages x Log | Reports | Design Runs ?_F0

Q T = T, B @ @) @ warning (2) @ Info (112) @ status (239)

» (= Vivade Commands (3 infos) -~

« [ Synthesls (2 warnings, 15 infos)
@ [Common 17-349] Got license for feature 'Synthesis' andfor device 'xc72020'
@ [Device 21-403] Loading part xc72020clg400-1

[Synth 8-2611] redeclaration of ansi pert d is not allowed [designl.v11]
@ [Synth 8-6157] synthesizing module *design1’ [designl.v:3]
@ [Synth §-6155] done synthesizing module 'designl’ (1#1) [designl.v.3]
@ [Project 1-571] Translating synthesized netlist
@ [Netlist 29-17] Analyzing 14 Unisim elements for replacement
@ [Metlist 29-28] Unisim Transformation completed in 0 CPU seconds

> @ [Preject 1.570] Preparing netlist for logic optimization (1 more like this)
@ [0pt 31-138] Pushed 0 inverter(s) to 0 load pin(s).

> @ [Project 1-111] Unisim Transformation Summary:
Mo Unisim elements were transformed. (1 mo

® [Common 17-83] Releasing license: Synthesis

[Constraints 18-5210] No constraints selected for write.
Resolution: This message can indicate that there are no constraints for the design, or it can indicate that the used_in flags are set such that the constraints are ignored. This later case is used when running synth_design to not write
synthesis constraints to the resulting checkpoint. Instead, project constraints are read when the synthesized design is opened.

@ [Common 17-1381] The checkpoint Yhome/amert/Documents/project 1/project 1.runs/synth_1l/designl.dcp' has been generated.
@ Iruntcl-4] Executing : report_utilization file designl_utilization_synth.rpt -pb designl_utilization_synth.pb
© [Common 17-206] Exiting Wivado at Tue Oct 4 17:13:39 2022...
~ [ Implementation ( )
» = Design Inttialization

e this)

3 info

(7 infos)
= Opt Design (25 infos)
© [Common 17-349] Got license for feature Implementation’ and/or device 'xc72020'
@ [Project 1-461] DRC finished with 0 Errors
© [Project 1-462] Flease refer to the DRC report (report_drc) for more information.
© [Timing 28-35] Done setting XDC timing constraints,
@ [Opt 31-49] Retargeted 0 cell(s)
5> @ [0pt 31-138] Pushed 0 inverter(s) to 0 load pin(s). (1 more like this)
> @ [Opt 31-289] Phase Retarget created O cells and removed 0 cells (4 more like this)
@ [Opt 31-662] Phase BUFG optimization created 0 cells of which O are BUFGs and removed O cells
@ [0pt 31-1064] SRL Remap convertad 0 SRLs to 0 registers and convertad 0 registers of register chains to 0 SRLs
© [Pwropt 34-132] Skipping clock gating for clocks with a period < 2,00 ns.
@ [Common 17-83] Releasing license: Implementation
© [Timing 38-480] Writing timing data to binary archive.
@ [Common 17-1381] The checkpoint Yhome/amert/Documents/project_l/project_1.runs/impl_l/designl_opt.dcp’ has been generated.
© [runtcl-4] Executing : report_drc file designl_drc_opted.rpt -pb designl_drc_opted.pb +px designl_drc_opted.rpx
O [IP_Flow 19-234] Refreshing IP repositories
© [IP_Flow 19-1704] No user IP repositories specified




Adding Xilinx IPs to your Design



IP Catalog

* Clickon IP Catalogunder Flow Navigatorto see the list of available Xilinx IPs.
* You can use Search bar to find IPs.

PROJECT MANAGER - project_1

Project Summary x| const.xdc x| IP Catalog x

o

i

2 .

5 || cores | Interfaces

@

ol z = [® = m

E Search:

t

qé Name A1 axa Status License VLNV
~ PROJECT MANAGER o ||~ = Vivado Repaository

o Settings b Alliance Partners

> Audio Connectivity & Processing

Add Sources Automotive & Industrial

AXI Infrastructure
Language Templates
AXIS Infrastructure
TF IP Catalog BaselP

Basic Elemeants

Communication & Metworking

Debug & Verification
~ Digital Signal Processing

> Building Blocks

> Filters

> Modulation

> Transforms

> Trig Functions

> Waveform Synthesis
v Embedded Processing
> AXI Infrastructure
> AX| Peripheral
> 2XIS Infrastructure




Adding Xilinx IPs to your Design
(Example: DSP48 Macro)



IP Catalog Example: DSP48 Macro

e Xilinx FPGAs have dedicated, full-custom, low-power DSP slices.
e 7 Series DSP48E1 Slice User Guide
https://docs.xilinx.com/v/u/en-US/ugd79 7Series DSP48E1

e Search for DSP48 Macro and double click on it.

PROJECT MANAGER - project_1

Cores | Interfaces

Sources

Search: DsP

Name
~v [ Vivado Repository

IF Froperties

v Basic Elements
D5P48 Macro

Project Summary x | const.xdc

o = ¢ [# o £

« IP Catalog =

@ e,

(1 match)

AL ax4 Status License  WLNW

Production Included  xilinx.com:ip:xbip_dsp48_macro:3.0



https://docs.xilinx.com/v/u/en-US/ug479_7Series_DSP48E1

IP Catalog Example: DSP48 Macro

e Xilinx FPGAs have dedicated, full-custom, low-power DSP slices.
e 7 Series DSP48E1 Slice User Guide
https://docs.xilinx.com/v/u/en-US/ugd79 7Series DSP48E1
* Search for DSP48 Macro and doubleclick on it.

48-Bit Accumulator/Logic Unit

>
A P
> ) >
25x18
D Ed Multiplier
> Pre-adder
>
Pattern Detector

1 F

UG4TE_el_21_032111


https://docs.xilinx.com/v/u/en-US/ug479_7Series_DSP48E1

IP Catalog Example: DSP48 Macro

e Xilinx FPGAs have dedicated, full-custom, low-power DSP slices.
* First, set the component name.

Customize IP x

DSP48 Macro (3.0) y

@ Documentation - IP Location C Switch to Defaults

IP Symbol  Instruction summary Component Name |xbip_dsp48_macro_0
[ show disabled ports Instructions  Pipeline Options | Implementation
8] A¥B+C -
1 # -
2 # -
3 # -
4 # -
) # -
CLK
5] # -
A[17:0]
7 # -

P[47:0]

B[17:0]
C[47:0]

863 # El

Above instruction list specifies instructions 8 to 63: use a comma to delimit multiple instructions

() show Filtered



IP Catalog Example: DSP48 Macro

* DSP unit providesvarious functionalities.

DSP48 Macro (3.0)

‘ @ Documentation IP Location C Switch to Defaults ‘
i

IP Symbol  Instruction summary Component Nama  xbip_dsp48_macro_0

(1) Show disabled ports Instructions  Pipeline Options | Implementation

0 2484C -
i AB+C A
AB+C+CARRYIN
2 A%B+CARRYIN
3 ARB+P
A*B+P+CARRYIN
N AB+P=217
s AYB+P==17+CARRVIN
CLK . ARB+PCIN e
A[17:0]
7 # -

B[17:01]

Cl47:01 e : N

Above instruction list specifies instructions 8 to 63; use a comma to delimit multiple instructions

[[) show Filtered




IP Catalog Example: DSP48 Macro

* Asanexample, we select A*B as functionalityand set the component name as mult_unit.
* You will use the component name for instantiatingthe DSP unitin your design

DSP48 Macro (3.0) /
@ pocumen tation - IP Location C' Switch to Defaults
ymbol  Instruction summary P me  mult_u
how disabled p ot pelin I
0 A8 -
1 # v
2 v
3 -
4 v
-
CLK h
Al17:0]1 P[35:0] 7 # v
B[17:0] 863 # El
Above instruction list specifies instructions 8 to 63: use a comma to delimit multipl
Show Filtered



IP Catalog Example: DSP48 Macro

* You canset the pipelineoptions.
* As anexample, we use two level of pipelineregisters

Customize IP X

D5P48 Macro (3.0) P

© Documentation - IP Location C Switch to Defaults

IP Symbol  Instruction summary Component Name  mult_unit

() show disabled ports Instructions | Pipeline Options  Implementation
Pipeline Options | Expert -

Custom Pipeline options

Tier: 1 2 3 4 5 6
- -
A O o 0|, |0 =]}
B O -> O » 0—¥ @'\_, ]
CLK 5}
A[17:0] P[35:0] c > > Y 5 0
BI17:0] o~ =~ [ E— s
- - —_— e
KEY: Fabric register

DSP register

Control ports

Global D A B CONCAT M P SEL/CARRYIN
CE (]

SCLR O



IP Catalog Example: DSP48 Macro

You can set input/output port widths.

We set A and B width as 25 and 18 (an signed 25-bit x 18-bit multiplier)
Finally, click on OK and then Generate to create the DSP.

DSP48 Macro (3.0)
@ Documentation IP Location € Switch to Defaults

1P symbol  Instruction summary

() Show disabled ports

CLK
A[24:0]
B[17:0]

P[42:0]

Component Name |mult_unit
Instructions | Pipeline Options | Implementation

Input Port Properties

D 18 [2-2] A 25
B 18 [2 18] C |48
CONCAT 48 [2- 48]

Output Port Properties

Output Properties | Full Precision  ~ | Full Precision Width 43

width a3 [2-4g]
Additional ports

() use acour [J use BeouT () use PcouT

() Use CARRYOUT  [_) Use CARRYCASOUT

) Use DSP Slice

Generate Output Products

The following output products will be generated.

/’

Preview
Q x 2
~ mult_unit.xci ( per IP)

Instantiation Template
Synthesized Checkpoint (.dep)
Structural Simulation
Change Log
Synthesis Options
Global
(®) out of context per IP
Run Settings
®) On local host: Number of jobs: 4 ~
) On remote hosts

) Use LSF:




IP Catalog Example: DSP48 Macro

* You will see the DSP IP under Design Sources
* Inorderto see the IP ports, expand the IP hierarchyand click on OK.

Sources 2 = B
Q| = 8|+ &
v (= Design Sources (2

® . designl (designl.v

> 1[5 [mult_unit (mult_unit.xci)]

v = Constraints

v 7 constrs_1 (1
I const.xdc
v = Simulation Sources (2
v i osim_1 (2
v @~ designl_tb (designl_tb.v) (1
@ dut : designl (designl.v
> mult_unit (mult_unit.xci)
> Utility Sources

Show IP Hierarchy X

OK to Show IP Hierarchy?
For large IPs, this may slow down source hierarchy updates,

[[] Don't show this dialog again




IP Catalog Example: DSP48 Macro

* You will see the DSP IP under Design Sources
In order to see the IP ports, expand the IP hierarchyand click on OK.

* Double click on mult_unit.vhd to see the module ports.

Sources
Q = &+
v = Design Sources (2
@ . designl (designl.v

>4 Eult_unit (mult_unit.?'i')j}

Constraints

v 7 constrs_1 (1
I const.xdc
v [ Simulation Sources (2
v i osim_1 (2

@ dut : designl (designl
> mult_unit (mult_unit.xci)
> Utility Sources

v @ = designl_tb (designl_tb

?

-0oX

v Design Sources (2) |
v fmuilt vnit Cmnlt Gt i) (1]

~ @ mult_unit(mult_unit_arch) (mult_unit.vhd) (1)
“ U0 : wbip_dsp48_macro_v3_0_17(xilinx]
® . designl (designl.w)

Show IP Hierarchy X

OK to Show IP Hierarchy?

For large IPs, this may slow down source hierarchy updates,

[[] Don't show this dialog again

Project Summary x| const.ydc x| IP Catalog x| mult_unit.vhd x
/homefamert/Documents/project_1'project_1.sresfsources_Liip/mult_unit/synth/mult_unit.vhd

Q B E 0

CENTTTY muls it T
o PORT (
CLK : IN STD_LOGIC;
4 : IN STD_LOGIC VECTOR(24 DOWNTO 8);
8 : IN STD_LOGIC_VECTOR{17 DOWNTO @) ;
P : OUT STD_LOGIC VECTOR(42 DOWNTO ©)
'H
5 | END mott_unit;




IP Catalog Example: DSP48 Macro

* You will see the DSP IP under Design Sources
* Inorderto see the IP ports, expand the IP hierarchyand click on OK.
* Double click on mult_unit.vhd to see the module ports.
* You caninstantiatethe module (mult_unit) with module ports.

wire [24:0] mult unit A;
wire [17:0] mult unit B;
wire [42:0] mult unit P;

mult unit MU (clk,
mult unit A,
mult unit B,
mult unit P);




Adding Xilinx IPs to your Design
(Example: Multiplier)



IP Catalog Example: Multiplier

e Xilinx FPGAs provide a multiplier core. This core allows paralleland constant-coefficient
multipliersto be generated. The user can specify if DSP48 Slices, LUTs or a combination of

resources should be utilized.
* 7 Series DSP48E1 Slice User Guide
https://docs.xilinx.com/v/u/en-US/pgl108-mult-gen
* Search for Multiplier and double click on it.

Project Summary x« IP Catalog

Cores | Interfaces

al = = [# = m
Search: Multiplier] (4 matches)
Name A1 pya Status License  WLNW

v [ Vivado Repository
v Digital Signal Processing
W Building Blocks
Complex Multiplier AX14-Stream Production  Included  xilink com:ip:cmpy: 5.0
W Math Functions

v Multipliers
Comnlex Multinlier AX|4-Stream Production  Included  xilink.comiip:cmpy: 6.0

Multiplier Production  Included  xilinx com:ip:mult_gen:12.0



https://docs.xilinx.com/v/u/en-US/pg108-mult-gen

IP Catalog Example: Multiplier

* Xilinx FPGAs provide a multipliercore.

* Set the component name and select one of multiplier types
* Parallel Multiplier or Constant Coefficient Multiplier
* Setinput options
* Data type: Signed or Unsigned
* Bit width: 2to 64
*  Multiplier construction: Use LUT or Use Mults (DSPs)
*  Optimization options: Speed optimized or Area optimized

Multiplier (12.0) P
@ Documentation = IP Location ' Switch to Defaults

1P Symbol Component Name | mult_gen
Show disabled ports Basic “OUrpUr and contrar

Multiplier Type

Input Options
P= A - B

= CLK
= A[17:0] P{35:0] m=
= B[17:0]

cancel



IP Catalog Example: Multiplier

* Xilinx FPGAs provide a multipliercore.

* Information tab shows resource estimate (LUT6s, DSP48 slices, 18K BRAMSs) based on the
Multiplier type and Input options.

Multiplier (12.0)

/

@ Documentation IP Location C' Switch to Defaults

1P Ssymbol | Information Component Name |mult_gen
Resource Estimates Basic  Output and Control
LuTes 64 Multiplier Type
DSP48 slices ]
18K BRAMS 0

® Parallel Multiplier () Constant Cosfficient Multiplier
Additional Information

- Input Options
estimates do not include SRLs.

P= A - B
Reseurce counts may not reflact
true post-implementation resource usa
when a custom output width is used Data Type | Signed | | signed e
and the output product MSB
is less than full precision MSE. Wwidth 18 18
Rangs: 2...64 Rangs: 2...64
Multiplier Construction = Use LUTs v

Optimization Options | Speed Optimized

Area:The multiplier will be optimized to reduce slice logic and overall area
Speed:The multiplier will be optimized for performance




IP Catalog Example: Multiplier

* Xilinx FPGAs provide a multipliercore.

* Information tab shows resource estimate (LUT6s, DSP48 slices, 18K BRAMSs) based on the
Multiplier type and Input options.

Multiplier (12.0)

/

@ Documentation IP Location C' Switch to Defaults

1P Ssymbol | Information Component Name |mult_gen
Resource Estimates Basic  Output and Control
LuTes 64 Multiplier Type
DSP48 slices ]
18K BRAMS 0

® Parallel Multiplier () Constant Cosfficient Multiplier
Additional Information

- Input Options
estimates do not include SRLs.

P= A - B
Reseurce counts may not reflact
true post-implementation resource usa
when a custom output width is used Data Type | Signed | | signed e
and the output product MSB
is less than full precision MSE. Wwidth 18 18
Rangs: 2...64 Rangs: 2...64
Multiplier Construction = Use LUTs v

Optimization Options | Speed Optimized

Area:The multiplier will be optimized to reduce slice logic and overall area
Speed:The multiplier will be optimized for performance




IP Catalog Example: Multiplier

* Xilinx FPGAs provide a multipliercore.
* Parallel Multiplier example
* In Output and Control tab, you can adjust the number of pipeline stages (optimum pipeline
stages are proposed by the core based on multiplier type and input options)
* Finally click on OK and generate to create the IP block.

Multiplier (12.0) P Multiplier (12.0) /
@ Documentation [ IP Location C' Switch to Defaults @ Documentation [ IF Location C Switch to Defaults
Ip Symbol  Information Component Name  mult_gen P symbol  Information Component Name  mult_gen

Resource Estimates Basic  Output and Control Resource Estimates Basic  Output and Control

LTSS 0 Multiplier Type LuTSS 0 output Product Range
D3F48 slices 4 D3P48 slices 4
18K BRAMs o (@® Parallel Multiplier () Constant Coefficient Multiplier 18K BRAMs o Use Custom Output Width
Additional Information Additional Information OutpLt MSB |63
Please note that the LUT resource Input Options Please note that the LUT resource Output LSB |0 0-
estimates do not include SRLs. P = A . B estimates do not include SRLs.
Resource counts may not reflect Resource counts may not reflect
true post-implementation resource DataType | Unsigned + | [Unsigned " true post-implementation resource output product width (max, min) = (63,0)

when a custom output width is uses
and the output product MSB
i less than full-precision MSE.

when a custom output width is use!
and the output product MSB
Width 22 2 is less than full-precision MSE.

Range: 1...64 Range: 1...64
9 9 Pipelining and Control Signals

Multiplier Construction | Use Mults v Pipeline Stages optimum pipeline stages: 6
-

1

Optimization Options | Speed Optimized Clock Enable Synchronous Clear
2

Area:Optimizes the muttiplier for DSP4S slice resources by splitting the multiplication between DSF4¢ 3

Speed:Optimizes the multiplier for performance using as many DSPAE slices as nacessary Synchrenous Controls . jriority | SCLR Overrides CE
5
5
7

< > < > < > 8

9
10




IP Catalog Example: Multiplier

* Xilinx FPGAs provide a multipliercore.
* Constant Coefficient Multiplier example

* In Basic tab you can set the constant integer (second operand) and memory type to
implement constant multiplier

* In Output and Control tab, you can adjust the number of pipeline stages (optimum pipeline
stages are proposed by the core based on multiplier type and input options)

* Finally click on OK and generate to create the IP block.

- e )

Multiplier (12.0) ¢ Multiplier (12.0) /
@ Documentation = IP Location  C Switch to Defaults @ Documentation - IP Location C Switch to Defaults
Information _omponent Name  mult_gen symbol | Information Component Name | mult_gen

Basic

Resource Estimates Resource Estimates sic | output and control

LTSS 249 Multiplier Type LuTes 249 Output Product Range
DSR4 slices o DSP4B slicas 0
18K BRAMs 0 18K BRAMs [

Parallel Multiplier (®) Constant Coefficient Multiplier Use Custom Qutput Width

Additional Information
Please note that the LUT resource

Input Options

Additional Information

Please note that the LUT resource

Output MSB |48

output LS8 |0

estimates do net includs SALs. P = A « B estimates do not include SRLs
Resource counts may not reflect Resource counts may not reflect
true post-implementation resource Data Type |Uneigned <1 [Sonca true post-mplementation resource VLITPLT PrOGUCT WITTA (M@K, MIN) = (4¥, 0)
when a custom output width is use: P! £l 9 when a custom output width Is uses
and the output product MSB widkh = = and the output product MSE
is less than full-precision MSB. 4 is less than full-precision MSB,
Range: 1...64 Range: 2...64 Pipelining and Control Signals
Coefficient Pipeline Stages Optimum pipeline stages: 4
a ~
Constant Value (Integer) 123456 Range: (2763)..(2764-1) Clock Enable 2 Synchranous Clear
Memory Type | Distributed Memory synchromous controls| 3 Iriority | SCLR Overrides CE
4
Distributed Memol
) Selects the FPGA resource that should be used to buid the 5
Block Memory constant-coefficient multiplier
Dedicated Multiplier 6
< > < 5 8
9
10 N

| e



Adding Xilinx IPs to your Design
(Example: Block Memory Generator)



IP Catalog Example: Block Memory Generator

e Xilinx FPGAs have dedicated block memory primitives
e Block Memory Generator Product Guide
* https://docs.xilinx.com/v/u/en-US/pg058-blk-mem-gen
* Search for Block Memory Generator and double click on it.

Project Summary x| const.xdc x| IP Catalog x

Cores | Interfaces

al = 2 7 < & ® o,
Search: Block Memory Generator (2 matches)
Name AT A4 Status License VLNV

v vivado Repository
~ Basic Elements
Block Memaory Generator AX4 Production  Included  xilink.com:ip:blk_mem_gen: 8.4
~ Memories & STorage ElIements
v RAMs & ROMs & ERAM
Block Memaory Generator AX4 Production  Included  xilink.com:ip:blk_mem_gen:8.4



https://docs.xilinx.com/v/u/en-US/pg058-blk-mem-gen

IP Catalog Example: Block Memory Generator

e Xilinx FPGAs have dedicated block memory primitives
* Set the componentname and select one of available memory types
* Asanexample, we select Simple Dual Port RAM and name the component as
bram_unit
)

Block Memory Generator (8.4)

/’

@ Documen tation ' IP Lacation € Switch to Defaults

IP Symbol  Power Estimation Companent Name  bram_unit

Show disabled ports Basic  Port A Options | Port B Options | Other ootions | summarv

Port Ais used for WRITE

Interface Type | Native A Generate address interface with 32 bits

MemoryType | Simple Dual POrt RAM v | oo

|| = BRAM_PORTA

ECC Options
= P addral3:01 ECC Type No ECC ~
= clka
> Single Bit Error Injection
— P dina[15:0]
Port Bis used for READ — pena write Enable
B wealnN-N1 Byte Write Enable
([— BRAM_PORTB Byte Size (bits) | 9
= P addrb[3:0]
Algorithm Options
— P clkb Defines the algo used to concatenate the block RAM primitives.
< douth{15:0] Refer datasheet for more information
: Algorithm | Minimum Area
— P enb
Primitive B2
< >



IP Catalog Example: Block Memory Generator

* You canset the data width and depth of Port A and Port B. We set width and depth as 32
and 256 respectively. This memory unit can store 256 of 32-bit words.
* You can enable optional output register of Port B
(If you enableit, read latency will be 2 cycles instead of 1)

Component Name |bram_unit| Compenent Name  bram_unit

Port A Options Port B Options
Memory Size Memory Size
Port Awidth 32 Range: 1 to 4508 (bits) Port B Width | 32 A
Port B Depth : 256
Port ADepth 256 Range: 2 to 1048576

The Width and Depth values are used for Read Operation in Port B
The Width and Depth values are used for Write Operations in Port A

operating Mode | Read First Enable Port Type | Use ENB Pin v
Operating Mode No Change +~  Enable Port Type  Use ENAPin v
Port B Antinnal Autnut Banictars
port A Optional Output Registers ] Primitivas Output Register Core Output Register
REGCEE Pin

Port B Output Reset Options
Port A Output Reset Options
RSTB Pin (set/reset pin)  Output Reset Valus (Hex) 0
Output Reset Value (Hex) 0
Reset Priority | CE (Latch or Register Enable
Reset Priority | CE (Latch or Register Enable

READ Address Change B
READ Address Change A




IP Catalog Example: Block Memory Generator

* You cansee the summary of memory unit that you generated.
e Bit-width of ports, read latency ...
* Finallyclick on OK and generate to create the IP block.

Customize IP *
Black Memory Generator (8.4) ’ Generate Output Products x

© corumenzation P Locsuen © Switch to Defaults The following output products will be generated. p
1P Symbol |
how disabled ports [: C n: Port B v i ptior Summary

ram 00C per IF)
Instantiation Template
Synthesized Checkpoint (.dcp)

structural Simulation
Change Log

— Synthesis Options
|| + BRAM_PORTA ) Global
||+ eram_porTe ® Out of context per IP
Run Settings
(®) On |ocal host: Number of jobs: 4 -
() on remote hosts

J Use LSF:

@

cance
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